NI DIAdem™

Getting Started with DIAdem
Worldwide Technical Support and Product Information

ni.com

Worldwide Offices
Visit ni.com/niglobal to access the branch office Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and current events.

National Instruments Corporate Headquarters
11500 North Mopac Expressway   Austin, Texas 78759-3504   USA   Tel: 512 683 0100

For further support information, refer to the Technical Support and Professional Services appendix. To comment on National Instruments documentation, refer to the National Instruments Web site at ni.com/info and enter the Info Code feedback.

© 2003–2014 National Instruments Ireland Resources Limited. All rights reserved.
Legal Information

Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in materials and workmanship, for a period of 90 days from the invoice date, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult contemporary documentation if errors are suspected. In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THEREFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

End-User License Agreements and Third-Party Legal Notices
You can find end-user license agreements (EULAs) and third-party legal notices in the following locations:

• Notices are located in the \Legal Information and \Legal directories.
• EULAs are located in the \Legal\license directory.
• Review \Legal\license for more information on including legal information in installers built with NI products.

Trademarks
Refer to the NI Trademarks and Logo Guidelines at ni.com/trademarks for more information on National Instruments trademarks.

ARM, Keil, and µVision are trademarks or registered of ARM Ltd or its subsidiaries.

LEGO, the LEGO logo, WEDO, and MINDSTORMS are trademarks of the LEGO Group.

TETRIX by Pitsco is a trademark of Pitsco, Inc.

FIELDBUS FOUNDATION™ and FOUNDATION™ are trademarks of the Fieldbus Foundation.

EtherCAT® is a registered trademark of and licensed by Beckhoff Automation GmbH.

CANopen® is a registered Community Trademark of CAN in Automation e.V.

DeviceNet™ and EtherNet/IP™ are trademarks of ODVA.

Go!, SensorDAQ, and Vernier are registered trademarks of Vernier Software & Technology. Vernier Software & Technology and vernier.com are trademarks or trade dress.

Xilinx is the registered trademark of Xilinx, Inc.

Tiptie and Trilobular are registered trademarks of Research Engineering & Manufacturing Inc.

FireWire® is the registered trademark of Apple Inc.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

Handle Graphics®, MATLAB®, Real-Time Workshop®, Simulink®, Stateflow®, and xPC TargetBox™ are registered trademarks, and TargetBox™ and Target Language Compiler™ are trademarks of The MathWorks, Inc.
WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS’ TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.
## Contents

### About This Manual
Related Documentation ........................................................................................................ vii

### Chapter 1
**Introduction to DIAdem**
- Working with DIAdem ........................................................................................................ 1-1
- The Introduction Screen .................................................................................................... 1-3

### Chapter 2
**Finding Data**
- Mining Data ................................................................................................................ 2-1
  - Executing a Quick Search ........................................................................................... 2-1
  - Executing an Advanced Search ................................................................................ 2-2
- Browsing in Data Sets ..................................................................................................... 2-4
- Loading and Managing Data .......................................................................................... 2-5
  - Saving Data ............................................................................................................... 2-6
- Summary ......................................................................................................................... 2-7

### Chapter 3
**Viewing and Evaluating Data**
- Viewing Curves ............................................................................................................ 3-1
- Editing Curves .............................................................................................................. 3-3
  - Measuring Curves ...................................................................................................... 3-3
  - Copying Curve Sections ............................................................................................ 3-3
- Editing Data in Channel Tables ..................................................................................... 3-5
- Summary ......................................................................................................................... 3-7

### Chapter 4
**Analyzing Data with Mathematical Functions**
- Using Mathematical Standard Functions .................................................................... 4-1
  - Calculating the Sum of Channel Values ....................................................................... 4-2
  - Averaging Channels .................................................................................................... 4-3
- Calculating with the Units Catalog ............................................................................... 4-4
- Calculating Formulas with the Calculator ..................................................................... 4-6
- Summary ......................................................................................................................... 4-8
About This Manual

You can use this manual to familiarize yourself with DIAadem features and how to use them. Each chapter describes a DIAadem panel.

This manual contains exercises for finding, analyzing, and presenting data, and for automating functions to process your data. The exercises do not take long, and they make it easier for you to get started with DIAadem. Each chapter concludes with a summary of the main points.

Related Documentation

For more information on DIAadem, refer to the following documentation:

• **NI DIAadem: Data Mining, Analysis, and Report Generation**
  This DIAadem manual describes the structure of DIAadem and how you use DIAadem to find data, to execute analyses, to create reports, and to combine all the functions in scripts.

• **DIAadem Help**, which you open via Help>Contents, or <F1>.
  The DIAadem help offers you procedures and dialog box help for each panel, as well as references to object oriented interfaces, to functions, to commands, and variables for programmers.

• **NI DataFinder Server Edition: Search Engine for Technical Data**
  This manual describes how you use the DataFinder server to index data files in networks. Users connect DIAadem with a DataFinder server to search for the indexed data.
Introduction to DIAdem

DIAdem is the interactive National Instruments software for finding and managing technical data, for mathematically and graphically-interactively analyzing data, and for presenting data in reports. In a standardized environment, DIAdem offers a unique combination of tools that are tailored to the requirements of technicians, engineers, and scientists. You can adjust all the tools to your tasks and automate them in scripts, which reduce evaluation time substantially.

The DataFinder enables you to find test data quickly and easily, and to identify corresponding data. To use the DataFinder you do not require a database or support from the IT department because the DataFinder is ready for use directly after installation.

Working with DIAdem

DIAdem groups related functions in panels. Use the panel bar that is on the left of the DIAdem screen to switch panels. Each panel provides all the tools for one of the following tasks:

- Use DIAdem NAVIGATOR to find, to load, and to manage data. Use the DataFinder to search for data on your computer and in the network, and to navigate through the found data files and databases. You load the data into the Data Portal so that all DIAdem panels can work with the data, which is organized in channels.

- Use DIAdem VIEW to view, to analyze, and to edit data as curves in axis systems. In channel tables you can edit and delete the data as values and enter new data. You synchronize videos or the map display of a test drive with data. You project data onto 3D models or map 3D data in two-dimensional contour areas.

- Use DIAdem ANALYSIS to analyze data mathematically. You can apply predefined standard mathematical functions, including basic mathematics, curve fitting, signal analysis, and statistics. The dialog boxes for these standard functions guide you through the calculation so you do not have to enter a formula. You select the input data and the settings. Use the DIAdem Calculator to define and calculate your own formulas.

- Use DIAdem REPORT to document data and present results. In 2D and 3D axis systems you display your data as curves, as bar diagrams, and as surfaces. In 2D and 3D tables you list channel contents. You can label your report with comments and text and illustrate the report with graphics and formulas.

- Use DIAdem SCRIPT to automate tasks in a script, which combines several work steps for recurring sequences such as standard calculations and serial evaluations. Scripts, which you can record interactively, use the functions of all DIAdem panels. You can add program structures and dialog boxes to scripts in the integrated script editor.
Chapter 1  Introduction to DIAdem

When you select a panel, DIAdem changes the user interface so that you can quickly find the functions you want. Each DIAdem panel has its own group bar to the right of the panel bar as shown in Figure 1-1. Open a group bar, click a function group, and select a function. The workspace also changes with the DIAdem panel and displays a folder hierarchy or a worksheet. The toolbars and the context menus contain frequently used functions, which DIAdem also adapts to the selected panel.

Figure 1-1. The Elements of the DIAdem User Interface

<table>
<thead>
<tr>
<th>1</th>
<th>Panel bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Group bar</td>
</tr>
<tr>
<td>3</td>
<td>Function group</td>
</tr>
<tr>
<td>4</td>
<td>Tooltip of the selected function</td>
</tr>
<tr>
<td>5</td>
<td>DIAdem VIEW toolbar</td>
</tr>
<tr>
<td>6</td>
<td>Data Portal</td>
</tr>
<tr>
<td>7</td>
<td>DIAdem VIEW workspace</td>
</tr>
<tr>
<td>8</td>
<td>Properties in the Data Portal</td>
</tr>
</tbody>
</table>
The Introduction Screen

When you launch DIAdem, the DIAdem introduction screen appears. The introduction screen includes video tutorials and examples that show you how to work with DIAdem. The information on DIAdem contains tips for newcomers and for advanced users and leads you to related information on the internet.

Note If DIAdem does not display the introduction screen when DIAdem launches, select Help » Introduction to open the introduction screen.

Use the tutorials in the introduction screen to learn how to use DIAdem. The DIAdem panels contain tutorials in the tutorials function group that explain the respective panel. Refer to the DIAdem website ni.com/diadem for further videos.

Use the Examples Gallery or the ExampleFinder to load and execute examples and to use these examples as templates for your own applications. The table of contents of the ExampleFinder contains procedures which are step-by-step instructions for the solution of certain tasks. Reproduce the steps of a procedure to learn how to solve the described task.
Finding Data

Use DIAdem NAVIGATOR to find, to load, and to manage data. Use the DataFinder to search for data on your computer and in the network, and to navigate through the found data files and databases. You load the data into the Data Portal so that all DIAdem panels can work with the data, which is organized in channels.

Mining Data

Use the Quick Search to search for a term if you do not know whether the property belongs to a file, a group, or a channel. Use the Advanced Search to combine several search conditions and to specify which properties you are searching for.

Executing a Quick Search

To find data with a Quick Search, complete the following steps.

1. Select DIAdem NAVIGATOR.

The file browser in the NAVIGATOR panel offers external data in a tree structure.

2. Enter Weather in the input area, to find all the data sets that contain the term Weather.

3. Click Search.
Chapter 2  Finding Data

In the quick search DIAdem does not distinguish whether the data set contains the term as
the name or the property of a file, of a channel group, or of a channel. DIAdem displays all
files that contain the term *Weather* or compound terms such as *Weather data*, as
Search Results, as shown in Figure 2-1.

Figure 2-1. Search Results of the Quick Search

Executing an Advanced Search

To find data with an **Advanced Search**, complete the following steps.

1. Click the **Advanced Search** button to specify the search results more accurately, as shown
   in Figure 2-2.

Figure 2-2. Selection List with the Channel Names of the Indexed Data
2. Click **File** in the first row of the **Level** column and select **Group**.
   a. Click **<Enter a property>** in the **Property** column of the first row and select **Name**.
   b. Click the button with the three dots at the end of the first line. DIAdem lists the names of all the groups found.
   c. Double-click the group name *Weather*.

   **Note**  If the list does not contain the term *Weather*, DIAdem has not been able to index all example files yet. Select **Settings»My DataFinder»Configure»Indexer»Start Now** to start indexing.

Define another search condition in the second row to specify the search more accurately.

3. Click **File** in the second row of the **Level** column and select **Channel**.
   a. Click **<Enter a property>** in the **Property** column of the second row and select **Name**.
   b. Click the button with the three dots at the end of the second row. DIAdem lists the names of all the channels found, as shown in Figure 2-2.
   c. Double-click the channel name *Precipitation*.

As you can see in the logical operations line below the search conditions, DIAdem connects several search conditions with the AND operator by default.

4. Replace **AND** with **OR** in the logical operations line to create the following operation:
   
   C1 OR C2

5. Click **Search**.
DIAdem displays the **Search Results**, as shown in Figure 2-3. Each of the listed files contains a group with the name *Weather* or a channel with the name *Precipitation*.

**Figure 2-3. Search Results of the Advanced Search**

---

**Browsing in Data Sets**

Complete the following steps to open data files in the file browser in order to inspect search results.

1. Right-click the `Data1.tdm` file in the search results to open the context menu.
2. Select **Display in File Browser** from the context menu.

   DIAdem switches from the search results to the file browser and displays the `Data1.tdm` file with the TDM file symbol in the tree structure.

   If the file browser knows the file format, it displays the respective file symbol before the file. If the file browser does not know the file format, it displays the file symbol with a question mark.

3. Click the plus sign in front of the file symbol to view the channel groups.

4. Click the plus sign in front of the *Weather* channel group to view the channels.
5. Click the **Precipitation** channel.

DIAdem lists all the channel groups and channels that are contained in a file, in a tree structure. You can browse down to the channel level in the files if the file format supports browsing. You can find further information on the selected file, channel group, or channel in the **Properties** window below the **File Browser**, as shown in Figure 2-4. If you select a channel, the channel preview to the right of the properties display shows the channel data as a curve.

**Figure 2-4. Browsing the Found Files in the File Browser**

---

**Loading and Managing Data**

If you want to work with the data you found, you must load the data into the Data Portal. To load data and to remove unnecessary data, complete the following steps.

1. Click **Delete Internal Data** on the toolbar.

2. Click the **Weather** channel group in the file browser to select this channel group.
3. Drag and drop the selected channel group into the Data Portal.

The Data Portal displays the Weather channel group with all the channels, as shown in Figure 2-5. If you select a channel, the channel preview of the Data Portal displays the channel data as a curve.

Figure 2-5. Loading Data from the File Browser to the Data Portal

Note If you modify data in the Data Portal, DIAdem does not save the changes automatically. The changes are executed only in the memory and not in the data file from which you loaded the data. This enables you to experiment with data without modifying the original data.

Saving Data

To save the data in the Data Portal, complete the following steps.

1. Navigate to the DIAdem folder Data in the National Instruments folder.
2. Select the Weather channel group in the Data Portal.
3. Drag and drop Weather to the Data folder.
4. Enter the file name Weather data in the Save As dialog box.
5. Select the file type National Instruments TDM Files (*.tdm).
6. Click Save.
Summary

The summary provides an overview of the topics discussed in this chapter. It also includes additional information.

DataFinder

In the search input area of the DataFinder, you enter search conditions to find your data. You can also drag and drop properties from the properties display of the Data Portal or of the file browser into the search input area. In the logical operations line, you connect the search conditions with AND and OR and use parentheses to specify queries more precisely. DIAdem lists the files found in the search areas on the Search results tab.

DataFinder Server Edition

The DataFinder Server Edition indexes data files in the network and enables up to 25 DIAdem users to access common search areas simultaneously. You can enable security settings and use archiving systems.

Search Areas

Search areas are folders of the file system, which the DataFinder indexes. Select Settings > My DataFinder > Configure to modify the search areas of the DataFinder.

File Browser

The File Browser displays the files of the search areas in a tree structure. Right-click the empty space of the file browser to open the context menu and hide or show the folders of the local file system in a separate tree.

Internal Data in the Data Portal

DIAdem manages internal data in the Data Portal, which is visible in all panels. In all DIAdem panels you work with the channels of the internal data and their descriptive information. DIAdem saves result data in the Data Portal. You can display and edit the channel contents in DIAdem VIEW.

Tip You do not need the <Shift> or <Ctrl> keys to select several channels in the Data Portal; just click the symbols next to the channel names. DIAdem displays a cursor with a plus sign.

Channel Groups

Channel groups contain channels and descriptive properties of the channel groups. Use different channel groups to organize your data. You can define a channel group as a default group, for example, to automatically group together all the calculation results from DIAdem ANALYSIS. DIAdem displays the group name of the default group in bold type.
Chapter 2 Finding Data

Channels
Channels contain data series which you either measured, loaded from an external data set, or calculated with DIAdem. DIAdem distinguishes numeric channels, waveform channels, time channels, and text channels. Numeric channels contain numeric values, waveform channels contain numeric values and the associated x-channel as a generation instruction, time channels contain time values, and text channels contain text.

Properties
Properties are information about the data, which DIAdem saves with the data series in a TDM file. The data set properties contain the name of the author and the storage date, the channel group properties contain the name of the measurement and comments, and the channel properties contain the data type and the channel unit. In addition to the standard properties, you can create your own custom properties for the data set, the channel group, and the channel. DIAdem displays the properties in the properties displays of the file browser and of the Data Portal.

Units Catalog
The channel unit is a special channel property because you can organize the channel units in the units catalog. Use the units catalog to assign a physical quantity and a unit to measurement values, for example, the quantity speed and the unit kilometers per hour. If you assign the unit mile per hour from the units catalog to the speed channel, DIAdem can convert the channel values.
Viewing and Evaluating Data

Use DIAdem VIEW to view, to analyze, and to edit data as curves in axis systems. In channel tables you can edit and delete the data as values and enter new data. You synchronize videos or the map display of a test drive with data. You project data onto 3D models or map 3D data in two-dimensional contour areas.

Viewing Curves

To view the loaded data set in an axis system, complete the following steps.

**Note** If you have not completed the exercise from the previous chapter, delete the data in the Data Portal and load the data set Data1.tdm located in the DIAdem Data folder. You find this folder in the DIAdem NAVIGATOR file browser in the search area National Instruments.

1. Select DIAdem VIEW.

2. Click New Layout.

3. Click Regular Worksheet Partitions on the group bar.

4. Click Two Areas in this function group.

**Note** Each panel has its own group bar on the left side. When you click a button on the group bar, DIAdem opens the function group where you can select a function.
Chapter 3  Viewing and Evaluating Data

5. Select the Date time channel in the Data Portal.

6. Click the symbol in front of the channel name to also select the numeric channels $T_{\text{max}}$ and $T_{\text{min}}$. The cursor changes its color and displays a plus sign.

7. Drag and drop the three channels selected in the Data Portal into the upper worksheet area.

8. Select 2D Axis System in the selection dialog box. DIAdem displays the axis system, as shown in Figure 3-1.

**Figure 3-1. Viewing Temperature Data as Curves**

![Image of DIAdem with temperature data as curves]

**Note** If you select several numeric channels in the Data Portal and drop the channels onto an axis system, DIAdem assigns the first channel you select to the x-axis. If you select only one channel, DIAdem uses the index to display a numeric channel and uses the x-part to display a waveform channel.
Editing Curves

In DIAdem VIEW you can measure curves, and copy, delete, and interpolate curve sections. Use the curve cursor, the maximum values cursor, or the minimum values cursor on the DIAdem VIEW toolbar to measure a curve. To edit curve sections, use the flag functions on the axis system toolbar. The functions on the toolbar of the axis system influence the curves in the associated axis system, whereas the functions on the DIAdem VIEW toolbar influence all areas.

Measuring Curves

To follow the curve points with the curve cursor in an axis system, complete the following steps.

1. Click **Curve Cursor** on the toolbar.

2. Click the axis system and move the curve cursor along the curve.
   DIAdem displays the x-values and the y-values of the curve points in a tooltip next to the crosshair cursor that follows the cursor.

3. Click the red checkbox on the right side of the axis system to select a different curve as the leading curve.

   **Note** You can use the second checkbox next to the curve symbol to hide and show the curve in the axis system.

   DIAdem displays the coordinates of the new leading curve in the tooltip.

Copying Curve Sections

To select a curve section and to copy the data of the curve section into the Data Portal, complete the following steps.

1. Click **Band Cursor** on the toolbar.

2. Click the axis system at 3/13 and drag open the band cursor up to 12/12.
   Click between the two lines to move the band cursor along the curves. Move the cursor lines to specify the width of the band cursor.
Chapter 3  Viewing and Evaluating Data

3. Click **Set Flags** on the axis system toolbar to mark the points of the leading curve in the selected time segment.

   ![Set Flags Icon]

   **Note** If you press <Shift> at the same time, DIAdem marks the points of all curves in this section.

4. Click **Flags: Copy Data Points** on the axis system toolbar to copy the data of the marked curve points to new channels.

   In the Data Portal, DIAdem creates a time channel and a numeric channel with the values of the copied curve section.

5. Drag and drop the new channels into the bottom workspace.

6. Select **2D Axis System**. DIAdem displays the copied curve section, as shown in Figure 3-2.

   **Figure 3-2.** Selecting Curve Sections and Copying them into the Data Portal
7. Click **Remove Flags from All Data** on the DIAdem VIEW toolbar to undo the selections.

**Editing Data in Channel Tables**

In channel tables you can edit and delete data and add new data. You can enter or generate new data manually.

To edit values in a channel table and to generate new values, complete the following steps.

1. Click **Assigned Worksheet Partitions** on the group bar.

2. Click **Channel Table** in this function group.

3. DIAdem creates a new worksheet with a channel table.

4. Select the channels **Comments**, **CopyXDate**, and **CopyYT_max** in the Data Portal.

5. Drag and drop the channels selected in the Data Portal into the channel table.

   DIAdem displays the columns in the order in which you select the channels in the Data Portal.

6. Click the cell in the **CopyYT_max** column, row **10**.

7. Enter the value **1** and press <Enter>.

   DIAdem also displays the new value in the curve in the bottom axis system on the previous worksheet.

8. Right-click next to the channel table or into an empty column and select **Create New Channel** from the context menu.

   a. Enter the channel name **Generated_Channel**.

   b. Click **OK** to create the new channel in the channel table and in the Data Portal.

9. Right-click the first cell of the empty column **Generated_Channel** and select **Generate** from the context menu.

   a. Enter **0.5** as the step width and **100** as the number of values.

   b. Click **OK** to create the channel values.
DIAdem displays the channel table, as shown in Figure 3-3.

To use the layout with all worksheets as a template for similar data sets, click **Save Layout As**.
Summary

The summary provides an overview of the topics discussed in this chapter. It also includes additional information.

Layouts
A layout can contain several worksheets. DIAdem saves layouts separately from the channels. You can reuse the layout as a template for data sets with a similar structure.

Areas
Partition worksheets into areas to insert axis systems, channel tables, videos, 3D models, contours, maps, dialog boxes, text, and images. You can move the separating bars to resize any area in a worksheet. Use the Assigned Worksheet Partitions function group to add new worksheets with predefined areas to a layout.

Axis Systems
DIAdem VIEW provides 2D axis systems, polar axis systems, Bode axis systems, orbit axis systems, and shaft centerline axis systems which all display data as curves. In 2D axis systems you can display data as spikes or stair curves and add constants. To insert data into an axis system, drag and drop channels from the Data Portal into an axis system. Use the band cursor and the frame cursor to zoom curve sections. You open the legend on the right side of an axis system.

Graphics Cursor
DIAdem VIEW offers various graphics cursors for evaluating curves in axis systems. The free cursor moves freely in the axis system and the curve cursor follows the curve from curve point to curve point. Other graphics cursors determine the maximum values and the minimum values of a curve. If an axis system contains several curves, the graphics cursor follows the leading curve that you specify with the checkboxes in the legend. DIAdem synchronizes all the cursors of a worksheet with each other and with videos and 3D models.

Flags
Use the band cursor and the frame cursor to mark curve sections with flags, to delete, to copy, or to recalculate the marked curve points.

Channel Tables
In channel tables you view the individual values of all channel types, edit the values and add new values or channels. In the display properties of a channel table, you can specify whether a channel table only displays the channels that were dragged and dropped into the table or whether the channel table automatically displays all channels of a group or of the Data Portal.
Chapter 3 Viewing and Evaluating Data

Videos
In video areas you show videos. If you display the associated measured values as curves in an axis system, you can move a graphics cursor along the curves to display the video frame associated with each measurement value. Double-click an empty video area to insert a video.

3D Models
In model areas you project the measured or simulated data as a color shading or as a deformation onto a model of the test object. For example, you display temperatures as color shading on a climate dummy, and you display strain on bridge elements as deformation. To do so, you insert the 3D model of the test object and connect each data channel with the respective model point. For model points with no sensor, DIAdem interpolates the values from the data of neighboring model points.

Contours
In contour areas you display 3D data two-dimensionally by displaying the third dimension of the data as a color value and with isolines. You can use a contour display, for example, to display and to analyze characteristic diagrams. If you move the graphics cursor over a contour, DIAdem displays the associated isolines dynamically. You can save the data of every associated isoline and also the x-parallel and y-parallel intersection in the Data Portal.

Maps
In map areas you display geographic data in map sections. For example, you can follow the route of a test drive when you move the graphics cursor in an axis system along the data, such as consumption, RPM, and torque, collected during the test drive. To do so, enter the recorded longitude and latitude and, for example, the time channel for synchronization.

Dialog Boxes
In dialog boxes you enter values, check settings, or start functions to change the displays in other areas of the layout during the analysis. You can include every user dialog box to which you added the control VIEWConnector in the dialog editor of DIAdem SCRIPT.
Analyzing Data with Mathematical Functions

Use DIAdem ANALYSIS to analyze data mathematically. You can apply predefined standard mathematical functions, including basic mathematics, curve fitting, signal analysis, and statistics. The dialog boxes for these standard functions guide you through the calculation, so you do not have to enter a formula. You select the input data and the settings. Use the DIAdem Calculator to define and calculate your own formulas.

Using Mathematical Standard Functions

DIAdem has extensive libraries with standard mathematical functions in several function groups in DIAdem ANALYSIS. The results of the calculations are displayed in new channels in the Data Portal.

Note If you have not completed the exercise from the previous chapter, delete the data in the Data Portal and load the data set Data2.tdm located in the DIAdem Data folder. You find this folder in the DIAdem NAVIGATOR file browser in the search area National Instruments.

To create a new group for the calculation results, complete the following steps.

1. Select DIAdem ANALYSIS.

2. Right-click in the Data Portal and select New Group from the context menu.

3. Enter Results as the Name. Enable the checkbox Set default group.

4. Click OK.

DIAdem displays the name of the default group in bold type in the Data Portal.
Calculating the Sum of Channel Values
To total the precipitation for the year 2012, complete the following steps.

1. Click **Statistics** on the group bar.

2. Click **Descriptive Statistics** in this function group.

3. Click the button with the three dots at the end of the **Channels** entry field in the **Object to be evaluated** area.

4. Select [1]/**Precipitation sum**.
   
   This notation means the **Precipitation sum** channel is in the first channel group.

5. Click **OK**.

6. Enter 2–13 as the **Rows**.

   **Tip** To check which rows the precipitation for 2012 is in, switch to DIAdem VIEW and load the channels **Month** and **Precipitation sum** into a channel table. The **Month** channel contains the time values for the monthly precipitation totals.

7. Click **All Off** on the **Characteristic Values** tab to clear all the checkboxes of the characteristic values.
8. Select **Sums»Measured values**.

   DIAdem displays the **Descriptive Statistics** dialog box, as shown in Figure 4-1. The dialog box displays the channel preview of the precipitation sum in the top right-hand corner and displays the result data below the channel preview.

   ![Figure 4-1. Precipitation Summation in Sections](image)

   **Note** If you want to execute further calculations with this standard function, click **Calculate**. The dialog box remains open for further entries.

9. Click **OK** to calculate the sum and to close the dialog box.
10. Right-click **Results/Sum** in the Data Portal and select **Rename**.
11. Enter **Precipitation_2012** as the channel name and press <Enter>.

### Averaging Channels

To calculate the average monthly temperatures, complete the following steps.

1. Click **Channel Functions** on the group bar.

2. Click **Average Channels** in this function group.
Chapter 4 Analyzing Data with Mathematical Functions

3. Click the button with the three dots at the end of the **Channels** entry field in the **Channels to be averaged** area.
4. Select \([1]/Tm_{\text{min}}\).
5. Press <Ctrl> and also select \([1]/Tm_{\text{max}}\).
6. Click **OK**.

   DIAdem displays the dialog box, as shown in Figure 4-2.

   **Figure 4-2. Averaging Minimum and Maximum Temperatures**

   ![Averaging Minimum and Maximum Temperatures](image)

7. Click **OK**.
8. Right-click **Results/Mean** in the Data Portal and select **Rename**.
9. Enter **Temperatures** as the channel name and press <Enter>.

### Calculating with the Units Catalog

The DIAdem units catalog organizes physical quantities and the associated units. Use the units catalog to convert channels into other units.

To convert the calculated average monthly temperatures from degrees Celsius to degrees Fahrenheit, complete the following steps.

1. Click **Channel Functions** on the group bar.

2. Click **Convert Channel Unit** in this function group.
3. In the Channel entry field in the dialog box area Channel to be calculated, you find the channel [2]/Temperatures.
   If you see a different channel there, select Results/Temperatures in the Data Portal, and drag the selected channel into the entry field.

4. Select Units To °F Degree Fahrenheit, as shown in Figure 4-3.

   **Figure 4-3. Converting Channel Units with the Units Catalog**

5. Click OK.

6. Right-click Results/UnitConverted in the Data Portal and select Rename.

7. Enter Temperatures_F as the channel name and press <Enter>.

   **Note** You also can convert channel data to a different unit in the Data Portal. To do so, click the unit entry field in the properties display and click the button with the three dots to open the Symbol Input Help dialog box.
Chapter 4  Analyzing Data with Mathematical Functions

DIAdem ANALYSIS displays a record of the calculations, as shown in Figure 4-4, and the Data Portal displays new channels with the calculation results.

**Figure 4-4. Record of the Calculations with Standard Functions**

Refer to Figure 5-3 in the next chapter to view the curves of the average temperatures and the annual precipitation.

**Calculating Formulas with the Calculator**

Use the DIAdem Calculator to calculate your own mathematical formulas. In the Calculator you calculate with channels, variables, and values you enter. DIAdem stores the results in channels or variables.

To calculate the difference between the monthly maximum temperatures and the average temperatures, complete the following steps.

1. Click the **Calculator** on the toolbar.

2. Enter the following formula in the Calculator entry field.

   \[
   \text{Ch("Results/TmMax_Diff")=} \text{Ch("[1]/Tm_max")} - \text{Ch("[2]/Temperatures")}
   \]
Tip  Instead of typing in the entire formula double-click a channel on the Channels tab. DIAdem inserts the channel name with the group index and the variable Ch at the cursor.

Figure 4-5. Calculating Formulas with the Calculator

3. Click Calculate.
4. Click Close.

DIAdem adds the new channel TmMax_Diff to the Results channel group in the Data Portal.
Chapter 4 Analyzing Data with Mathematical Functions

Summary
The summary provides an overview of the topics discussed in this chapter. It also includes additional information.

Mathematical Functions
DIAdem ANALYSIS offers a variety of standard functions for analyzing your data. You assign input channels to standard functions, set parameters, and execute the calculation. Click OK to execute a calculation once and to close the dialog box. Click Calculate to execute several calculations with the same standard function.

Result Channels
DIAdem ANALYSIS saves calculation results in new channels. This enables you to calculate new data without overwriting the existing channels. In most dialog boxes of the standard functions, you can select Store result in original channel to overwrite the existing channels.

Default Group
DIAdem stores the result channels of a calculation in the default group in the Data Portal. In the context menu you can define a different group as the default group. DIAdem displays the group name of the default group in bold type.

Calculator
Use the Calculator to specify your own formulas for analyzing data. The Calculator has functions that range from simple arithmetic functions to advanced scientific and engineering functions. Use the Calculator to calculate channels, variables, and single values. DIAdem stores the results in channels or variables.

Units
If you assign units from the units catalog to the original channels, DIAdem automatically determines the unit of the result channels. Based on the physical quantities and units of the original channels, the division of distance by time results in a speed with the unit kilometers per hour, for example. Use Options>Units to add your own units and to define unit sets with your preferential units.

Calculation Manager
To execute recurring analysis sequences with a mouse-click you can define simple as well as complex calculations in the calculation manager. An analysis sequence can contain user-specific formulas and default functions and can combine calculations when one calculation step accesses the result from a different calculation step.
Creating Reports

Use DIAdem REPORT to document data and present results. In 2D and 3D axis systems, you display your data as curves, as bar diagrams, and as surfaces. In 2D and 3D tables you list channel contents. You can label your report with comments and text and illustrate the report with graphics and formulas. You use the Chart Wizard to create and to modify 2D axis systems and polar axis systems.

Creating Axis Systems

To create a new layout with the Chart Wizard, complete the following steps.

Note If you have not completed the exercise from the previous chapter, delete the data in the Data Portal and load the data set Data3.tdm located in the DIAdem Data folder. You find this folder in the DIAdem NAVIGATOR file browser in the search area National Instruments.

1. Select DIAdem REPORT.

2. Click New Layout.

3. Select the channel Weather/Month and then the channels Weather/Precipitation sum and Results/Temperatures in the Data Portal.

4. Right-click a selected channel and select Chart Wizard from the context menu.

DIAdem opens the Chart Wizard and creates a new worksheet with an axis system. In the axis system, DIAdem displays the channels that are selected in the Data Portal as curves, as shown in Figure 5-1. DIAdem assigns the first selected channel to the x-axis.

In Step 1 you select the diagram type. In Step 2 you add or delete curves. In Step 3 you specify the diagram display on several tabs. The preview, as shown in Figure 5-1, directly displays how the diagram changes.
5. Click the diagram type **Line**, and then click the subtype **Lines with Several Y-Axes**.

**Figure 5-1.** The Chart Wizard Displays the Preview in the Worksheet

6. Click **Next** twice to open Step 3 of 3.

7. Select the **X-Axis** tab.

8. Enable **Manual from** for the value range and enter 01/01/2012 as the start and 12/31/2012 as the end.

9. Click **Finish** to create the axis system.

   In the axis system, DIAdem displays the monthly precipitation and the monthly average temperatures over the date.

**Tip** You can open the Chart Wizard at several points in DIAdem. If you want to display curves with various x-channels, open the Chart Wizard on the toolbar. If you want to integrate axis systems into the current worksheet, open the Chart Wizard from the **2D Axis Systems** function group or the **Polar Axis Systems** function group. If you want to edit an axis system, open the Chart Wizard from the context menu of the axis system.
Getting Started with NI DIAdem

Editing Axis Systems
You can move and resize axis systems or parts of an axis system. To make it easier for you to see which objects you can select, DIAdem displays an object in a blue frame as soon as the mouse cursor idles on the object. Double-click the object to open its settings.

Complete the following steps to display the precipitations as bars.

1. Double-click the red curve of the precipitation sum to open the associated curve parameter.
2. Select the Display mode Bars.
3. Click OK to close the dialog box.
   DIAdem displays the worksheet, as shown in Figure 5-2.

   **Figure 5-2. DIAdem Displays the Precipitation as Bars**

4. Single-click into the axis system to select it.
5. To reduce the width of the axis system, move the small square in the middle of the right edge of the selected axis system to the left.
Chapter 5  Creating Reports

Graphics and Lines

Illustrate reports with graphics and company logos. Use lines and rectangles to divide the worksheet or to highlight a description field.

To add a graphic to your worksheet, complete the following steps.

1. Click Graphics on the group bar.

2. Click Load Graphic in this function group.

3. Select Weather.jpg in the DIAdem Documents folder and click Open.

4. Click and drag the graphic to the right edge of the workspace. Resize the graphic by dragging the small squares at the corners of the graphic.

To prepare a description field on the right of the worksheet, complete the following steps.

1. Click Line and Arrows on the group bar.

2. Click Continuous Vertical Line in this function group.

DIAdem inserts a vertical line on the right edge. Move this line slightly to the left to widen the description field.

Using Text and Variables as Labels

Add text and variables to a report to explain the contents and highlight specific items. All texts can include formula expressions and DIAdem variables, which DIAdem updates along with the rest of the report. Double @ characters indicate to DIAdem which parts of the text to evaluate dynamically.
To add a text to your report, complete the following steps.
1. Click **Text** on the group bar.

2. Click **Text** in this function group. The cursor changes to a text cursor.

3. Click at the top of the description field in the worksheet, where you want to enter a heading.
4. Enter the text `Weather report` and press <Enter>.
5. Enter `@@CurrDate@@` in the second line.
6. Click outside the text to conclude the entry.
7. Click the text. To resize the text, drag the small squares at the corners of the text with the mouse.

### Adding and Formatting Channel Properties

Click the button with the three dots at the end of the entry field in the text editor dialog box to edit text and use variables and expressions. You can easily drag and drop channel properties from the Data Portal into the worksheet.

To add a channel property to your report and to edit the channel property, complete the following steps.

1. Select **Results/Precipitation_2012** in the Data Portal.
2. Click **Minimum** in the properties display of the Data Portal and drag the channel property into the description field.
3. Double-click the inserted text. The text editor displays the following text:

```
Minimum: @@Str(Data.GetChannel("[2]/Precipitation_2012").Properties("minimum").Value, "AutoAdj")@@
```

   a. Replace the first word `Minimum:` with the description `Annual precipitation`.
   b. Press <Enter> to position the value below the text.
   c. Enter `mm` at the end of the text.
4. Click the **Position** tab and select **Centered** as the Relative position.
5. Click **OK**.
6. Select all texts and the graphic and click **Center Vertically** on the toolbar.
Chapter 5 Creating Reports

DIAdem displays the worksheet, as shown in Figure 5-3.

**Figure 5-3. Using Text and Variables as Labels**

To use the layout with all worksheets as a template for similar data sets, click **Save Layout As**.
Summary

The summary provides an overview of the topics discussed in this chapter. It also includes additional information.

Layouts
A layout can contain several worksheets. DIAdem saves layouts separately from the channels. You can reuse layouts as templates for data sets with a similar structure.

Worksheets
Worksheets contain axis systems, tables, text, formulas, and graphics. To add data to the worksheet, drag and drop channels from the Data Portal into axis systems and tables. In addition to selecting data channels from the Data Portal, you also can add data channels by double-clicking an axis system or a table.

Select Settings»Layout Setup»Worksheet Parameters to change the page format of a worksheet so that, for example, the table of contents is in portrait format, whereas the diagrams remain in the landscape format.

Master Layout
Use a master layout to create a uniform appearance for reports. The master layout remains unchanged in the background of all worksheets and consists of a landscape master and a portrait master. To create a master layout, select File»Master Layout»New.

Chart Wizard
You can use the Chart Wizard to create and to modify 2D axis systems and polar axis systems. The preview function displays each changed setting in the worksheet.

Axis Systems
Use axis systems to display channels as curves, as bars, and as surfaces. You double-click an axis system to edit the displayed curves, to add new curves, and to delete existing curves. To zoom curve sections, change the scaling of the x-axis and the y-axis with the mouse wheel as soon as you position the cursor over the respective axis.

Tables
Use tables to list the contents of numeric channels and also text channels. You double-click a table to edit the displayed columns, to add new columns, and to delete existing columns.

Text
Use text to label worksheets. Select Add Curve Coordinate from the context menu of a curve to comment values. Text also can include variable information, such as filenames or the current date. For DIAdem, the @@ characters indicate a variable expression. Click Refresh on the DIAdem REPORT toolbar to display the current variable contents.
Chapter 5  Creating Reports

Formulas
Use formulas to display calculation instructions in graphics. DIAdem uses the formula syntax of the Mathematical Markup Language (MathML) used in word processing.

Decorations
Use comments, lines, arrows, rectangles, and circles in a worksheet to highlight certain areas or curve points.

Graphics
Use graphics and logos to illustrate worksheets. DIAdem supports numerous different graphic formats including PNG, BMP, JPG, TIF, and WMF.
Automating Sequences

Use DIAdem SCRIPT to automate tasks in a script, which combines several work steps for recurring sequences, such as standard calculations and serial evaluations. Scripts, which you can record interactively, use the functions of all DIAdem panels. You can add program structures and dialog boxes to scripts in the integrated script editor.

Creating Scripts

The recording mode is the easiest way to create scripts. When you enable the recording mode, DIAdem creates a new script in the script editor and records the steps you make in this script. To create a new script in the recording mode, complete the following steps.

1. Select **DIAdem SCRIPT**.

2. Click **Enable Recording Mode** on the toolbar to start recording the script.

3. Enter **DIAdem user** as the **Author** and **Manual example** as the **Comment**, as shown in Figure 6-1.

**Figure 6-1. Configuring the Recording Mode**

DIAdem writes this information directly into the script code to help you identify the script in the future.
Chapter 6  Automating Sequences

4. Click **OK**.
   The status bar displays the recording mode symbol.

5. Select **DIAdem NAVIGATOR**.

6. Click **Delete Internal Data** to delete the data in the Data Portal.

7. Enter **Weather** in the search input area of the quick search.
8. Click **Search**.

9. Drag and drop the **Data1.tdm** file into the Data Portal.
10. Select **DIAdem ANALYSIS**.

11. Click **Channel Functions** on the group bar.

12. Click **Average Channels** in this function group.

13. Click the button with the three dots at the end of the **Channels** entry field in the **Channels to be averaged** area.
14. In the selection dialog box that opens, select the channels [1]/Tm_min and [1]/Tm_max and click OK.
15. Click OK to calculate the mean values and to close the dialog box.
16. Select DIAdem REPORT.

![](image1.png)

17. Click Load Layout.

![](image2.png)

18. Select the layout Report2.tdr and click Open.

   DIAdem automatically refreshes the display to show the data set you have just loaded.
19. Select DIAdem SCRIPT.

![](image3.png)

20. Click Disable Recording Mode.

![](image4.png)
Chapter 6  Automating Sequences

DIAdem displays the recorded script in the script editor, as shown in Figure 6-2.

Figure 6-2. Recording Actions in the Script Editor

After the commenting header, DIAdem declares the MyFolders path variable and assigns to this variable the paths to the data folder and to the document folder. If you want the script to load the data file or the layout file from another folder, just change the paths at this point in the script.

Editing Scripts

In the recording mode you have recorded the search for weather data, loaded a data set, and created a report. Expand the recorded script to evaluate further weather data.

To select data interactively complete the following steps.

1. Replace the script line for loading the data file Data1.tdm
   
   Call DataFileLoad(MyFolders(0)&"Data1.tdm","TDM",""

   with the following script lines:

   Call WndShow("NAVIGATOR","OPEN")
   Call InteractionOn("Load Data4.tdm")

   The first script line opens the NAVIGATOR panel and the second line stops the script so that you can load data interactively.
2. After the last script line, enter the statement for hiding the DataPortal and use the CodeCompletion function to do so:
   a. Enter Portal.
      As soon as you enter the dot behind the Portal object, DIAdem offers the methods and properties available for this object, as shown in Figure 6-3.

      **Figure 6-3. CodeCompletion and SmartInfo Make Editing Objects Easier**

   b. Double-click **Visible** to insert this property into the script.
   c. Complete the script line as follows:

      ```
      Portal.Visible = False
      ```

      DIAdem displays the respective SmartInfo for every element in the selection list. Click **Display Help on this Subject** to open the help page on this object.

**Testing Scripts**

To test the modified script, complete the following steps.

1. Click **Run Script**.

The script opens the NAVIGATOR panel and displays in the **Search Results** all the data files that contain the term **Weather**.
2. Click the file symbol in front of the **Data4.tdm** file to select the file.
3. Drag and drop the selected file into the Data Portal.
4. Click the message box **Load Data4.tdm** to end the interaction.

The script opens the REPORT panel. DIAdem refreshes the date displayed in the header and hides the Data Portal, as shown in Figure 6-4.

**Figure 6-4.** Report Created with the Script

5. Click **Data Portal** to enable the Data Portal for further tasks.

Select **DIAdem SCRIPT** and click **Save File As** to save the script.
Summary

The summary provides an overview of the topics discussed in this chapter. It also includes additional information.

Scripts

Scripts allow you to execute a series of commands for finding data, loading data, analyzing data, and creating reports. You can use VBS functionality and DIAdem commands in scripts. You can integrate the standard dialog boxes in scripts or you can create your own dialog boxes.

Recording Scripts

In the recording mode DIAdem records the command for every action that you execute interactively, in a script.

<Ctrl-Shift-C>

In the recording mode, DIAdem does not usually record the value assignment for program variables. For example, press <Ctrl-Shift-C> in a DIAdem REPORT dialog box to record the values of the program variables. If DIAdem is not in the recording mode, press <Ctrl-Shift-C> to copy the program variable value assignment to the Windows clipboard. Then add these assignments to a script and modify the required program variables.

Script Editor

The script editor displays the program code of scripts. While you record actions in the recording mode, DIAdem records the commands directly in the script editor. Use functions such as go to line, bookmarks, restoring, and find and replace, to make script editing easier. Use the Microsoft Windows Script Debugger in the script editor to work through scripts step by step and to find errors.

If you click a command, a property, a method, or a variable, the SmartInfo displays the parameters of the command, the property, the method, or the value range of the variable. For further information click Display Help on this Topic.

CodeCompletion

If you enter the name of an object and complete the entry with a dot, the script editor offers the subobjects, events, properties, and methods that are available for this object. Add your selection to the object in the script with a double-click.

When you enter the first characters of a command, for example, and press <Ctrl-Spacebar>, the script editor automatically completes the command. If several commands start with these characters, the script editor offers a selection list of all the possible objects, commands, and procedures.
Chapter 6 Automating Sequences

Interaction Mode
When you use the interaction mode, you can stop your script and work interactively with DIAdem. Use the `InterActionOn` command to enable the interaction mode in scripts. To end the interaction mode, click the `End Interaction` button, which is on the toolbar in all panels or in the message box.

User Commands
To add commands to DIAdem, you can define user commands in a script. For example, you use user commands to run calculations in the calculator, to format axis systems in DIAdem REPORT, or to extend the range of functions in scripts.

User Dialog Boxes
Create user dialog boxes in the dialog editor in DIAdem SCRIPT to enter values, to request settings, or to start functions. Use events to connect elements from user dialog boxes and specify how the script proceeds depending on the previously specified settings.
Technical Support and Professional Services

Log in to your National Instruments ni.com User Profile to get personalized access to your services. Visit the following sections of ni.com for technical support and professional services:

- **Support**—Technical support at ni.com/support includes the following resources:
  - **Self-Help Technical Resources**—For answers and solutions, visit ni.com/support for software drivers and updates, a searchable KnowledgeBase, product manuals, step-by-step troubleshooting wizards, thousands of example programs, tutorials, application notes, instrument drivers, and so on. Registered users also receive access to the NI Discussion Forums at ni.com/forums. NI Applications Engineers make sure every question submitted online receives an answer.
  - **Standard Service Program Membership**—This program entitles members to direct access to NI Applications Engineers via phone and email for one-to-one technical support, as well as exclusive access to self-paced online training modules at ni.com/self-paced-training. All customers automatically receive a one-year membership in the Standard Service Program (SSP) with the purchase of most software products and bundles including NI Developer Suite. NI also offers flexible extended contract options that guarantee your SSP benefits are available without interruption for as long as you need them. Visit ni.com/ssp for more information.

For information about other technical support options in your area, visit ni.com/services, or contact your local office at ni.com/contact.

- **Training and Certification**—Visit ni.com/training for training and certification program information. You can also register for instructor-led, hands-on courses at locations around the world.

- **System Integration**—If you have time constraints, limited in-house technical resources, or other project challenges, National Instruments Alliance Partner members can help. To learn more, call your local NI office or visit ni.com/alliance.

You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch office websites, which provide up-to-date contact information, support phone numbers, email addresses, and current events.